
Power Tools Conference:
Advanced Illustrator Techniques
Session Description
If Photoshop is the mother of all designer applications, then Illustrator is surely its little sister. Most designers, this one 
included, use Auntie Illustrator on a rather simple level. We tend to create design elements, logos and such using Illustrator’s 

more or less basic tools. We use the Pen Tool, the Shape tool, the Swatches, Gradients and Pathfinder, and go about our 
business. But even though we may consider ourselves advanced users, there are always different, more clever, or just more 
useful techniques that we either underutilize, or choose to ignore completely. This two day Power Tools workshop will 
introduce you to a number of those under-utilized tools, giving you a few invaluable techniques you will find you will be 
using from here on. This seminar’s starting point assumes a good familiarity with Illustrator’s tools already, as well as a 

familiarity with output formats and media. 

Before we start, get an online connection and download the following file:

 http://shalat.com/dev/mw09/illustechniques.zip

Level: Intermediate, advanced

1. Working with Artboards

Multiple Artboards: The first thing we’re going to look at comes at you before you even put 

mouse to paper, as it were. Of the new features in CS4, Illustrator finally kicks the one page per 

document limitations. The new Multiple Artboards  feature has been a long time coming. Even 

back in the heady days of competition with Macromedia FreeHand, Illustrator resolutely kept 

to its one page per document. FreeHand, if you will recall had multiple page, and multiple 

page size capabilities way back in the days of version 5.5.  But that’s the past, and we’re not 

here to mull over the dark ages. We’re here to celebrate the present, and gripe toward the 

future.

Multiple Artboards opens up a whole new way of considering Illustrator documents. The area 

between InDesign and Illustrator has become grayer.  Multiple artboards let you create a 

document that flows from one page to the next. And those pages don’t have to be the same 

size or orientation. You may ask why is this such a boon. Well, that remains to be seen, whether 

it is or not. When setting up package designs, with tabs and variously shaped faces, you might  
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find the multiple artboard helpful in the prototype process. You’ll certainly find it useful when 

exporting illustrator files to InDesign, Flash, and of course PDF’s. But enough intro. Let’s take a 

look.

Since this is such a clamored for new feature, I’ll give you a basic intro to its use.

1. Open a new document. Everything should look pretty much the same as before, but for 

the addition of the Number of Artboards dropdown, and the ensuing reading path 

arrangement icons.  (See Fig1). 

First thing, though, that you should know is that this new version of Illustrator redefines the 

term Artboard from earlier versions. If in an earlier version of Illustrator, you thought of Pages, 

you should now replace that term in your mind with Artboards. When you increase the 

number of pages, uh, I mean Artboards,  to say, 4, you then have access to the arrangement of 

those Artboards and how they will read. The spacing area lets you set the space on the canvas 

between your artboards. You can have it at “0” if you like. I’m leaving it default here.

Fig1:

Clicking on the Advanced disclosure triangle will give you the color space options (CMYK 

versus RGB),  as well as the resolution of any raster effects you may use in your document. (See 

Fig.2).
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Fig2:

2. Name your document artboards, set it for RGB, with Raster Effects on High (300 ppi).  

Give the document 4 Artboards, and let’s just have them follow the pattern described by 

the first button icon in the New Document dialog window.

3. When the app opens, you’ll now see all four of your artboards, arranged in the fashion 

we designated a moment ago.  The active artboard will have a darker perimeter than the 

others.  See Fig 3.

Fig 3:
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We have four artboards here.  In this example each is of equal size and equally 

distributed.  There is also something else of note in this example. The whole of 

the AI interface is contained in a singular unified window frame. Windows 

users have had this feature for some time, but this is new to the Mac, and you’ll 

notice it in most CS4 applications.  It’s called the Application Frame View. You 

can access it from the Window menu. (see fig 4 to the right).

It lets you keep all your Illustrator tools in one clean, ordered area, and lets you 

drag the whole interface around as a single unit. If you work on multiple 

monitors, say, then this is a time saving feature. 

Okay, back to Artboards. Let’s say we want to change the size of one or 

another of the artboards. Here’s how.

1. From the tool bar, select the Artboard Tool (Shift + O). When you have the 

Artboard tool selected, the background of the canvas turns a medium gray 

color, rather than white. It’s a visual cue to let you know you’re in artboard 

editing,not artwork editing.

2. Let’s resize the second artboard. There are two ways to do this. The first is to 

select the artboard you want to resize, and drag on one of the perimeter 

anchor points. (see Fig 5)

Power Tools Conference:
Advanced Illustrator Techniques  Andrew Shalat

_____________
Page 4 of 55



Fig 5: 

This is a good way to eyeball the size. 

But there is a more precise way to do this as well.

3. With the artboard tool selected, point your cursor over the artboard tool options panel at 

the top of the window, and input the precise sizes you want. (Fig 6)

Fig 6: 

Done. 

Now let’s look at a document that already has multiple artboards, with art already existing. The 

easiest way for us to do this is to use what comes with the CS4 application. 

1. Under File, select New from Template. 

2.  From the Adobe templates, select Club > Promotional 2.ait

An untitled document will open in your application window. This particular template has 

four artboards: a poster, a flyer, a table tent and an ad.  
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Note that each is a different size, with different art and text, but each is also a related 

collateral piece to a whole set. And that’s an important thing to understand how and when 

to use multiple artboards.  (Fig 7)

Fig 7:

If you like, click on any of the artboards, then under View, choose Show Rulers, and then go 

back and choose Show Artboard Rulers.  You will see a set of green rulers automatically show 

up next to the selected artboard.  (See Fig 8)

Fig 8:
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Back to business. Let’s look at what we can do with those artboards.

1. Select the Artboard tool (Shift+O). 

2. Locate the tool settings at the top of the window, and select the icon button just to the 

right of the small trashcan button. This is the Move/Copy with Artboard option button.  

3. Click it once, so that the button is darkened. This enables you to move the contents of a 

particular artboard when you move the artboard across the canvas. (see Fig 9)

Fig 9:

4. Now, with that option chosen, click on the Ad artboard (labeled “04”) and drag it to the 

right. You’ll note that when you release, the artwork has moved along with it. (See Fig 10)
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Fig 10:

5. Next, let’s click once again, essentially toggling the Move/Copy with Artboard option 

button so that it is no longer dark, or enabled.  Now move the same artboard back to the 

left.  This time, you’ll see that the artwork stayed where it was, but the artboard moved. 

(Fig 11)

Fig 11:

6. Click Undo and undo again. Let’s return back to our original state.

7. Finally, with the Artboard tool, select Artboard 02. Hold down the Shift key, and click-

drag around just the upper left text block area on that page. As you move your cursor, 
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you’ll see the area you are designating is constrained to a square. But if you release the 

shift as you drag, you can conform the area to the rectangular shape of the text block. 

Most importantly, though, you are creating a new artboard directly on top of an existing 

one.  (see figs 12, 13).

Fig. 12:    Fig 13: 

Mind you, you can create up to 100 artboards per document. Now for the reason why we 

would do this: output. When we decide to output our document, as pages for print, or a PDF, 

say, then we will have 5 separate pages. The fifth artboard, which we’ve just created here, will 

be its own page, working as a sort of close-up or pull out from the larger original page. 

When we decide to print the document, we will also be able to scroll through the pages, 

previewing each, within the Print Dialog window. (Fig 14)
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Fig 14:

 

Exporting your document (File > Export), however, can result in one large document, similar to 

what you see in your Illustrator application window if you don’t click the “use artboards” 

checkbox during the export. (see Fig 15).

Fig 15:
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The main thing you need to see here is that multiple artboards let you create a complete set 

of documents within one document. A complete identity program, or simply a portfolio or 

presentation, all within one singular document, then exported to PDF, or Flash, or just print. 

Multiple artboards means versatility.

2. Using the Blob Brush

If you’ve heard anything about the new features of Illustrator CS4, The Blob 

Brush had to be one of them. The Blob brush is a sort of short cut tool, that lets 

you create shapes and closed paths similar in appearance to a calligraphic 

brush, but it does it in a slightly different, and new manner. Where in earlier 

versions of AI you’d use a brush to draw a path, which would have a sort of 

virtual look that in order to make a closed path, you’d have to Expand, this new 

version goes straight to the Expand part.

Now that probably doesn’t make much sense to you, so let’s just dive in and 

show you what I’m talking about. All will become clear.

1. First, open a new document in illustrator, and set it with only 1 artboard. 

We’ll keep this all simple.

2. Select the original Brush tool (B). From the tool options panel, choose a 

Brush style of 7pt round.

3. Draw an S shape on the page. It doesn’t matter how accurately you draw 

it, just so that you have a curvy shape.

4. Change your tool to the Direct Selection tool (A), and select the shape you 

created.  Note where the anchor points and path lie. (See Fig 16)
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5. Fig 16:

You should see the path line running down the center of the shape, with the effect of 

the round brush form outside of it. 

6. Now locate the Blob Brush in the tool panel. 

7. If you happen to be using a tablet and pressure sensitive pen, this will be more effective, 

but for this simple demonstration, we’ll just use the mouse. Draw a simple S shape on 

the artboard to the right of the other S.  Now switch to the Direct selection tool and 

select the shape.  Shift select both shapes and compare them. (Fig 17)
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Fig 17: 

8. Note the anchor points in the  new shape. They are on the outline of the shape, rather 

than inside.  The Blob brush tool creates paths with fills, but no stroke. In essence, the 

blob brush creates an already expanded closed path.

Of course, we’re working with just  a mouse, and not pressure sensitive palette (although 

I do recommend one for every illustrator). But even with these limitations, let’s look at 

what we can do to enhance this simple form.

One of the unique qualities of the Blob brush is its liquid aspect. That is, when you draw 

a second stroke with the tool, if you happen to touch an existing Blob stroke, or cross 

over it, the two Blob forms are joined, or unified.

Let’s try one easy.

9. Using the Blob brush, now draw a line across the blob “s”.  (see Fig 18)

Fig 18:
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10. Select the cross line with either the Selection tool, or the Direct Selection tool. (Fig. 19)

Fig 19:

The combining of closed paths just by drawing them over one another is is one of those 

features that in the long run, will open up many options. 

It’s more than simply taking the place of on of the Pathfinder functions, as it will allow 
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you to create more complex unified objects without a stop and start, looking for a tool 

palette. In fact, the Blob brush options (double click on the tool) lets you set the brush to 

“Keep Selected”,  which means that when you draw a merged path, all paths are selected 

and remain selected as you continue to draw.  Note that when Keep Selected is active, 

Selection Limits Merge is disabled.

Fig. 20:

This option is useful for viewing all paths that are included in the merged path.  

Choosing the “Selection Limits Merge” option, which is the default setting, lets you 

merge only with the selected artwork. If nothing is selected, the Blob Brush merges with 

any matching paths. 

11. Since the Blob brush tool creates paths with fills but no stroke, we can always apply a 

stroke to the form. Let’s do so here. With the Blob form still selected, choose a brush 

style, like Charcoal, and set the width at 8 pt.
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Fig 21:

Now, I’m not going to do anything with this form at this point, but just want you to be 

aware of this feature for later on.  I’ve included the Appearance palette in this picture for 

a reason. You can track your styles on the form through the Appearance palette. That 

means you can also revert them to a Basic Appearance, or add effects and filters from 

there as well.

So that’s the basics of the new Blob brush tool. We’ll touch on it again later on, but for 

now that should introduce you to how it works.
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2. Drawing from Live Trace

Many times when designing a logo, or creating an illustration, we have to rely on existing 

artwork, and not necessarily good, or even vector format either. That’s where Live Trace comes 

in. Now, don’t go moaning about how this is old stuff, and not advanced. Sure, in the past 

century we used to use a standalone application called Adobe Streamline to do this, and it 

was pretty darn good. But that’s the past. It’s over. Move on. 

The Live Trace command in both CS3 (where it finally worked) and CS4 (where it still works) is 

a great starting point for getting raster images into vector art, and further, converting them 

into Live Paint objects (more on that in the next section). 

1. Open a new document, Letter size, RGB, 300 ppi.

2. Place a raster image into your new Illustrator document. (File > Place). We’ll place 

something that should be on everyone’s Mac. In the Place dialog box, navigate out to 

Macintosh HD/Library/Desktop Pictures/Nature/Earth.jpg.

3. Place Earth.jpg on your page. You may have to resize it to fit. 

4. Click Live Trace. When the 

warning comes up about it 

being too large an image click 

through, and continue. Placed 

and resized, your page should 

look like this:

Fig 22: 

Note that when it’s selected it 

has a bounding box with cross 

lines. That signifies that it’s not 
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yet a vector. It’s just in preview.

5. The trace controls are all in a row, as it were, in the tool options bar at the top of the 

window. The first control to play with is the Threshold. By default it will be set at 128, 

right in the middle. If you increase that number, sliding it to the right, you’ll increase the 

amount of black in your image. If you go the other way, and decrease the number, 

sliding to the left, you’ll find less detail and add more white. Right more black, left more 

white. 

6. But this is a color image, so let’s make the vector conversion in color. From the Preset 

drop down menu, select Color 16. As a rule of thumb, it’s better to use fewer colors than 

many, since printing many color fills within many paths and anchor points, can cause a 

very slow print. Take a look at the 16 color image (Fig 23).

Fig 23: 

This is still a Live Trace. By that, you can change your preset to even fewer colors, for 

instance, or go for more. You can vary the controls and options, and make your own 

preset.  Play around with the various presets. Or…

7. Click on the Tracing Options Dialog (located just to the right of the presets drop down 

menu).  Inside this dialog window, you can make finer adjustments and save as your 

own preset. Be sure to have the Preview check box selected so that you can see the 
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different effects your adjustments will make. (Fig 24)

Fig 24: 

Besides the normal adjustments, like Grayscale or number of colors, note the “Ignore 

White” check box. When this is selected, any white areas in the final vector will be filled 

as None, or transparent. That’s an important and in many cases timesaving  feature to be 

aware of.

8. Press Cancel, and we’ll keep the Color 16 setting for the earth.jpg.

9. It’s time to make this image a true vector. Click “Expand”.

10. The result is a vector illustration with a whole lot of anchor points. (Fig 25)

Fig25:
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Let’s get rid of the black background area surrounding our globe. 

11. Choose the Direct Selection tool (A), and click once in the black area surround the globe.  

This will make the Fill color in the tool palette Black. 

12. Deselect the image by clicking outside of the image. 

13. At the top of the document window, to the right of the Preference button is the “Select 

Similar Options”. Click to reveal the drop down choices, and select Fill Color. (Fig 26)

Fig 26:

This new feature will quickly select all the similarly filled objects on your artboard. Since 

we designated the fill from our Direct Selection a moment earlier, as the black of the 

background in this image, all objects with that fill are now selected.

14. Delete the selected parts. If there is an outlying shape, just drag over and delete that as 

well. You should be left with a globe, with just a small bit of black around the perimeter. 
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Since the image is now a vector, we can refine the image further with our direct 

selection tool, brushes, and the like, or use it as we have it here. One conversion done.

Fig 27:

Now let’s look at another method of conversion, which in turn will lead us into the next 

section.

For this section, I’ll supply an image, called sailboatrace.jpg (you can find it online at http://

shalat.com/dev/mw09/illustechniques.zip). I cleverly named the image to simultaneously 

describe the image, and what we’re about to do to that image. Very cunning.

1. In a new blank letter size document, Place sailboatrace.jpg.  

2. Click Live Trace.  

3.  Once in the Live Trace mode, select the Tracing Options button. Check “Preview.”

4. Now let’s set up the image. In the Adjustments side, set it up as Mode: Color, Max Colors 

28. In the Trace Settings,  keep the Path Fitting at 2px, then make the Minimum Area 

4px. Leave the Corner Angle at 20. And most important now, select Ignore White.
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Fig 28:

5. Click Trace. 

Now even though we’ve clicked trace, we’re still in the Live Trace function. We don’t 

actually have a vector yet. Our next step is a choice. We could simply click Expand, and 

have our vector drawing plain and simple.  Or we could take this an extra step and click 

Live Paint, converting our raster image into not just a vector image, but a Live Paint 

group, opening up some interesting options for further illustrative work. So guess which 

we’re going to do.

6. Right. Click Live Paint. Save the illustration as livepaintboat.ai for now. We’ll get back to it 

in a bit.

Our resulting image is a vector illustration, Live Paint group. Which brings us to our next 

section, Drawing with Live Paint. 
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3. Drawing with Live Paint

First, what is Live Paint? Live Paint was first introduced in illustrator CS2, and continued to 

improve in CS3 and now CS4. Live Paint is a method of coloring vector segments in both fills 

and strokes, without worrying about layers, or stacking orders, treating each Live Paint Group 

as though it were all on a single flat surface. 

Let’s start with looking at a normal group of objects.

Here’s a simple group of objects: 

Fig 29

Take note of the normal bounding box. In order to modify individual colors or parts of this 

group, you would double-click on the group, and enter the isolation mode, where you could 
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then apply different fills, and strokes, change the shapes, or move each shape’s position in 

relation to the other. Then you’d back out of that to the original document. 

1. Draw a group of shapes to emulate the one shown above.

2. Choose the Live Paint tool from the tool palette, and click on the simple group of shapes. 

This will make it a Live Paint group. 

Here’s the same group of shapes, but as a Live Paint group:

Fig 30

The only visible difference so far here is the sparkle graphic in each of the bounding box’s 

anchor points. But that’s just to let you know you have a Live Paint Group, and not an ordinary 

group.
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When I choose the Live Paint tool and place the cursor over the Live Paint Group, my cursor 

shows three swatches. If you look, from left to right, at the preceding swatch, then the center 

swatch, then the third swatch, and then compare that to the actual Swatches palette, you’ll see 

that the Live Paint cursor swatches are in the same order. 

Fig 31:

Let’s play with this group a bit to see a few of the proclivities of Live Paint. 

1. To make sure the bucket will pour the correct color, hold the Option key while hovering 

your cursor over the center rectangle.  The center swatch is the active pouring color.

2. Move your cursor to the lower part of the red circle.
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3. Click to pour the orange color into the red area. Your group should look like Fig 32:

4. Now to show what makes this “Live” switch your tool to the Direct Selection tool (A), and 

click inside the area we just colored orange.

5. Click and drag the shape up into the rectangle.

Fig 33:
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Now slide the circle over to the right so that it intersects the triangle.

Fig 34:

The shapes and their fills are fluid. Live Paint Groups treat each area of polygons and shapes as 

different segments. As you move your Live Paint tool over the group, the various segments are 

highlighted. Each segment can be filled or stroked on the fly.  (Our in seminar discussion will 

go into this in more depth than here on the printed page). 

Fig 35:
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So by now you may be saying to yourself, well that’s all cool but what’s so great about it? I 

mean, what can I use it for? 

In order to show you a real time use, let’s start with a graphic that should be familiar to all of 

us. The example of the Olympics logo has been used for this purpose by both Deke 

McClelland and Mordy Golding before, and it is such a clear example of practical use that 

we’re going to borrow it as the example here too. 

Fig 36:

This is a starting point, but it’s not a correct logo. The circles in the logo interlock, whereas here 

they just lay one on top of another. We’ll use the Live Paint tool to make them interlock. You 

can download the file I’ve created for this at http://shalat.com/dev/mw09/olympics.zip

You’ll note that in the Swatches palette I’ve established a color group specific for the rings. 

Also note that in each of the five colors for the rings, there is a small triangle on the lower right 

corner of each swatch. That means these are Global colors. More on that later.
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1. First thing we want to do is change the black stroke to white. Select the whole group and 

change the stroke to white. 

Fig 37:

2. Choose the Live Paint tool from the tool palette. Position the tool where the lower part of 

the blue circle meets the yellow. Using the right arrow button, cycle through till you have 

the global yellow as the center swatch on the Live Paint bucket. Now pour the yellow into 

the segment where they two circles cross.

Fig 38:
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That takes care of a fill, but we still have to work on the strokes. By default, the Live Paint tool 

will work on fills.  

3. Double click on the Live Paint tool icon in the tool palette. In the ensuing Live Paint Bucket 

Options window, select Paint Strokes and click OK.

Fig 39:

4. Now when you position your cursor over a stroke segment, the Live Paint tool becomes a 

brush, ready to apply a color to a stroke. Position the cursor over the stroke on the yellow 

circle (see fig 40) and apply a white stroke. If the swatch isn’t on white, you can select 

stroke from the tool palette, then from the Swatch palette select white (you could also 

scroll through all the swatches until you arrive at the white swatch, but we haven’t got all 

day).
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Fig 40:

5. Now to the same to the stroke on the right. 

6. Both strokes white, let’s remove the crossing strokes on the top and bottom of our little 

yellow segment. In the tool palette, locate and choose the Live Paint Selection tool (one 

icon below the Live Paint tool).

7. Select the affronting stroke segments and delete them.

Fig 41:

8. Continue to go through the same process on each of the lower crossings of the green and 

red circles so that the circles overlap in the correct fashion. 
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There you have a practical use of the Live Paint tool. So next time you need to create the 

Olympics logo, you’ll be prepared.  I’m sure that’s a frequent occurrence. But just in case you 

have time to fill in between those occasions, let’s do one more quick exercise using these 

tools.

1. Open a new document. 

2. In the center of the single artboard, type “LOGO design”. Put a hard return between the 

words. Use a generic font, like Myriad, at around 114pt. That’s a good size.

Fig 45:

Now let’s add some life to this type. 

3. Make the word “LOGO” something heavy and industrial. In the following image I used 

Stencil. The word “design”, on the other hand should have a more lyrical quality. And for 

purposes of this demonstration, I insist you use Bickham Script Pro. Bickham Script is an 

OpenType font, and has a good amount of alternative glyphs and ligatures. You’ll see what 

I mean in a minute.

Fig 46:
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4. Now, as I was saying amoment ago about Glyphs...select Window > Type > Glyphs.

Fig 47:

5. When the Glyphs palette opens, choose Alternates for Current Selection from the drop 

down menu.

Fig 48:
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6. Select the letter “d” in design. In the Glyphs palette, you should see a number of alternate 

glyphs for that character.  Select the sixth form from the left and double click. 

Fig 49:

The “d” in design should now show that alternate form rather than the original standard 

letter form.

7. Now play around with the “s”, the “I”,  “g” and “n”. 

Fig 50:
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Swellegant.

8. With both the words LOGO and design outfitted so nicely, it’s time to make them graphics 

elements. Choose Type > Create Outlines.

Fig 51:

9. Select the words, which are now a Group, and Ungroup them (Shift+Command+G). Now 

select the “design” as a unit, and drag it over the “LOGO”, as I have in Fig 52. We want to 

make sure the loopy ascenders of the alternate glyphs cross over the heavy glyphs of 

LOGO.

Fig 52:
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10. With “design” still selected, change its fill to something that contrasts the black. I’ve used a 

convenient Red.

Fig 53:

If you choose another color, that’s fine. Just make sure that its a strong, contrast with 

whatever color you have set for LOGO.

11. Select both LOGO and design (essentially Select All).

12. Choose the Live Paint tool. Click on a blank area to make the elements a Live Paint Group.

Fig 54:
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13. Now we should look at our forms and decide which parts go in front and which go 

behind. Position the Bucket over any area of Black in the LOGO letters. Hold down the 

Option key, and the bucket will become a dropper. Click once, to fill the Bucket with the 

exact Black that is contained in the LOGO. Now fill the segments you want to hide with the 

Black. In some cases, you may need to make a piece of the LOGO black into the Red from 

“design”. 

Fig 55:

14.  As you work your way across the forms, you’ll start to see how you’re wrapping the 

ascenders form design in and out of the heavy LOGO letters. With your final result, you 

should have an elegant example of how to use the Live Paint tool for extraordinary design. 
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Fig 56:
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4. Cooler Color Control with Kuler

You’ll find the files we need for this section in the download 

http://shalat.com/dev/mw09/illustechniques.zip

One of the best things to come down the pike in a long time started out as an experimental 

website from Adobe, called Kuler. I’m still not sure how they want us to pronounce it, whether 

it’s koo-ler or kuh-ler. Obviously some developer engineers don’t have much practice with 

elegance in language, or how to make clear a homophonic pun. But be that as it may, I’ll call it 

Kuler. Oh, sorry. Pronounce that koo-ler. 

Kuler grew from just being an esoteric website to an integral part of the color controls inside 

Illustrator itself. But in order for us to get a good understanding of this excellent tool, we’ll 

start with the online site, and see how we can pull the color themes from the Kuler site 

(http://kuler.adobe.com) into our live illustrator workflow.

The Kuler site is pretty intuitive. It’s a good idea to get an Adobe ID (it’s free) so that you can 

save any color schemes you create, and so that you have access to all the other online assets 

that Adobe has to offer.

When you open Kuler, you’ll be greeted by a color group of five swatches, and below that a 

number of links. On the left are the navigation links. The second column has examples of color 

sets developed by other users. The third column has more information about the selected 

color set, that is simultaneously stretched across the top.  The next column is a set of buttons 

that let you add color sets to favorites, download a set, or make adjustments. Finally, the last 

column is just some news and other palaver form Adobe. 
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Let’s take a quick walkthrough the online site. 

Fig 57:

Before you do anything else, click on the large color set at the top. It will fill the screen, letting 

you really assess the harmony of these swatches. After you’ve perused that, you can and 

should explore this site. Click on the Links, or Community. Check out the Themes, root around 

the various parts. 

After you’ve seen what others have done, looked at the Links and eavesdropped on the 

community, it’s time to create your own color set.

1. Click on Create.

2. The currently selected color set will be the one you first see in the Create area.  Creating a 

new color set has to do with what are called Harmony rules. We’ll see Harmony rules in a 

moment when we open up Illustrator’s Color guide palette. 
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3. You have some choices here as to how to proceed. By default you’ll create your color set 

From a Color. The next column to the right then gives you some more choices.  These are 

the harmony rules in action. Click on Analogous, and see how the stems in the color wheel 

adjust. Then click your way through each of the subsequent rules, from  Monochromatic to 

Triad to Complementary, and so on. With each different rule, the corresponding arms on 

the color wheel adjust. One color in the color wheel is highlighted. That’s the Base color. 

You can at any time select a different base color by clicking on one of the large swatches 

and then choosing “Set as Base Color”. It’s pretty simple stuff really. The Kuler engine does 

all the hard work. All you have to do is point it in the direction you want to explore.

Fig 58:
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As you go through the various adjustments available via the harmony rules, you can then start 

playing directly on the color wheel itself. Grab any of the color circles at the end of arms, and 

move them around. Drag them in or out, or around. This is the real fun part. Depending on the 

rule you’re working under, the other colors will work in a corresponding manner.  When you 

are satisfied (momentarily, I’m sure), take a look at the large swatches below the wheel. You’ll 

see a bit of further adjustments, and information.

Fig 59:

This is one of the best utilities of Kuler. The comprehensive color 

information you get with any swatch you create opens up the world of 

color transfer and tanslation from one medium to another.  If you’re 

developing a logo for a company, for instance, and you want to have 

the correct formula for the corporate color, all you need to do is put the 

color into your color set on Kuler, and read the corresponding formulas 

for RGB (Red, Green, Blue), CMYK (Cyan, Magenta, Yellow, Black), HEX 

(hexadecimal values from RGB for the web), as well as LAB (Luminance, 

A and B channels)  and HSV (Hue, Saturation and Value or Lightness).

A second way to develop a color set is from an existing image. This new version of Kuler 

(updated in November, 2008) lets you upload your own images, or access otehr images via 

Flickr.

Inside the zip file package I’ve made available to you, you’ll find an image called 

“italiancheese.jpg”. If you wouldn’t mind uploading that, you’ll start to see how this works. 
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When your image comes up, you’ll find five color spots in the photo. You can move these 

around to designate a range of colors within your image. 

Fig 60:

You can adjust these colors in the 

same way you did above with a color 

set derived from a color. The next step 

is to name and save your color, add 

tags so that it can be indexed on the 

community, and then finally to 

download it to your own computer.

Fig 61:

So we have our color set, named 

italiancheese, derived, appropriately 

enough, from an image of, uh, italian 

cheese.  We’ve saved it, named it, given 

it tags, and now we want to download 

it. When you do download the set, it 

will be called italiancheese.ase. Put it 

somewhere on your computer that will 

be easily accessible. 

We now have saved our color set,  and 

we want to put it to use. So let’s open a file where we can do just that.
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From the zip file (http://shalat.com/dev/mw09/illustechniques.zip) locate the FOOD.ai file.

This is just an illustration I did some years back for a client. These were preliminary sketches for 

their logo, and were refined beyond the state you now see them here. But for the purposes of 

this instruction, they should work fine.

Fig 62:

1. Select all the image elements on the artboard.  Fig 62a:
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2. Open the Swatches palette, and from the disclosure button on the upper right, select “Add 

Selected Colors”. (see fig 63).

Fig 63:

This is simple way to have any inherited images come directly into 

your Swatch palette. But if you look closely, you’ll note that these 

newly imported colors have an extra feature.  The little triangle in the 

lower right corner of each of your newly imported swatches signifies 

that these new colors are Global. That in turn means that if you apply 

them to an element, and then through the swatch palette, you adjust 

or change that color, they will change in a corresponding manner in 

every element to which they’ve been applied.  

This is too good to just leave out there in the general swatch 

population, so we’re going to want to do something about that.  

Fig 64:

3.  Select the newly added global colors, and while 

still inside the Swatches palette, click on the New Color 

Group icon. You’ve now created a new color set. This is 

significant for several reasons. First, it will give you an 

easy access to those new colors, but more importantly, 

the color sets are accessible form within the Kuler 

color Guide palette, as we’ll see in a minute.

4.  Select the new color set.
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5. Open the Color Guide palette. Fig 65:

 

The Color Guide is the doorway to all those Kuler 

controls we discovered online. As you can see, the top 

area shows the complete color set. Click on the arrow 

on the right of the set, and you’ll see harmony rules 

that you should understand from your foray in Kuler 

online.

Fig 65a:

The plethora of color swatches below your harmony rule are acceptable and related 

shades and tints of your color set. Note that the Shades are not global, but the Tints are.

6. Let’s enter the Kuler wheel house. Click the gradated icon on the bottom of the Color 

Guide palette.
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Here we have a representation of our color set, in that now familiar Kuler color wheel. That 

means we have all the controls and adjustments available to us here that we had on the color 

wheel online. Fig 66:

We can play around in here and there are a number of controls which we’ll go into in the live 

seminar, to explain all those icons and adjustment sliders on the bottom. But for now, play all 

you want, but finally click either Cancel or OK to bring us back out to our Illustrator document.

7. Return to the Swatches palette and click the disclosure control at the upper right. 

Select Open Swatch Library, and from there drill down to Other Library…

8. Locate the italiancheese.ase file that you downloaded from the Kuler site. Fig 67:
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The color set comes into your Swatches palette, ready to go, in its own 

folder. But...note that the colors are not Global. That’s an easy fix. 

9.  Double click on each individual swatch in the set, and make sure to 

make them Global. Once they’re Global colors, and all is right with the 

world, open the Color Guide and click open the Color wheel 

(remember that little icon on the bottom)

.      
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10. Here’s where some of the color fun really starts. Select the italiancheese colors, and the 

wheel will limit your colors to just those colors. 

Fig 70:

This is the part that gets most confusing, since it’s where we adjust and assign colors so that 

we can replace our color sets wholesale, just by replacing one set with another. 

11. Select the images on the artboard. 

12. Return to the Color Guide, and click on the colorwheel icon. 

13. Now we’re confronted with a new interface. The Assign controls let us assign different 

colors to our existing colors. So rather than just adjusting the colors in the wheel, we 

can actually assign specific colors from existing color sets, other color sets in fact. Think 

about it. That means, we can create SPOT color seps from our Illustrator documents. 

Whoa.

The current colors shows us what our original illustration contains. To the right are the 

colors we want to change them to.  
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14. From the Preset drop down menu, select italiancheese. Now the 25 colors of your 

original can be changed to the five specific colors of italiancheese. Or any other color 

set.  Try replacing the limit to Brights, for instance. As you do this, keep an eye on your 

original illustration, and watch its automatic changes.

Fig 71:

Fig 71a:

You can designate any of the color shades, tints, or color sets you like, to limit your color 

transitions. There’s a lot of play in this aspect of Kuler, and it gets confusing. But when you start 

to use it, it becomes, just as most things in Illustrator, rather second nature.
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Fig 72:

Now if you think about it, you can also select from the Preset a color book, like say, Pantone 

Uncoated. So you can assign specific inks to what was previously an RGB or CMYK image. Or, in 

terms of just color design, you could just shift the whole illustration into a different tone. The 

power of the Kuler color control is pretty much limitless.Fig 73:
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Kuler inside Illustrator

One of the best things about the CS4 suite (isn’t that redundant? Creative Suite 4 Suite?) is its integration 

of Kuler controls within most of the applications. So you’ll find Kuler controls in Illustrator, Photoshop, 

InDesign, Flash, even Fireworks. Of course, it’s never as easy as just opening a main menu and finding 

Kuler right there. You have to search for it. You will find it following  this path:  Windows > Extensions > 

Kuler. 

Don’t become frustrated if the Extensions menu isn’t in exactly the same place in each application. 

Take your time and you’ll find it. In one case it may be three from the top,  as here in Illustrator, while in 

other cases, as in InDesign, it’s seven menus down (if you don’t count Arrange and Workspace, or then it 

would be ten).  

Select Kuler. The Kuler panel is partially dependent on you being connected to the internet. That’s 

because it’s taking a direct RSS feed from the Kuler site we discussed above. 

So the listings of color sets are live from the Kuler site. The cool (kule?) part 

of it is the button on the bottom right. If you select a color set, then click 

on the button at the bottom right, those colors will automatically appear 

in your Swatches panel. 

Of course, the Create button at the top is nagging at you, isn’t it? Using the 

same essential controls we saw in the Kuler site, the Create controls within 

this panel let us, well, create new color sets, or modify those we find in the 

listing from the site. 

The Create area will also let you adjust the brightness of each hue, change 

your base color, make their harmony rules whatever suits your particular 

needs.
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Once you’ve created your set to your satisfaction (or the satisfaction 

of your clients) you can save the set, or Theme, as they like to call it. 

Click Save Theme, name the theme and choose the Browse button 

again.
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Instead of seeing the Most Popular, or Newest, or Highest Rated, 

select Saved. Now you’ll find where your Theme or color set 

lives. From here on, it’s the same process. If you want these 

colors as a unified theme for your document, choose Add to 

Swatches.

As we know, once a set is a part of our Swatches panel, we can manipulate the color themes  using the 

color guide. On the other side of the coin, any color themes you come up with within Illustrator can be 

uploaded directly to the Kuler site as well. Click on the Upload to Kuler button. Easy.
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